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Passport Business Solutions™ 
Enhancements by Version 

     

 PBS Version 12.03  

 PBS Version 12.02 

 PBS Version 12.01 

 PBS Version 12.00.09 

 PBS Version 12.00.08 

 PBS Version 12.00.05 

 PBS Version 12.00.01-12.00.04 

 

 

  

PBS Version 12.03 

System Enhancements 

 MySet 

MySet™ is a new system-wide tool that allows each PBS user to set their default sorting option for any list box 

used in Graphical mode and the graphical lookups accessible in Character mode.  

 
A PBS Administrative user may designate any Graphical mode screen as view-only, by company, for any General 

user. 
 

Each PBS user may create default field settings for any Graphical mode report by company. 

 
Windows 8, Windows Server 2012 and Microsoft SQL Server 2012 Now Supported 

An updated runtime is part of the PBS 12.03 install that provides support for Windows 8, Windows Server 2012 

and Microsoft SQL Server 2012. 

Expanded Print Reports from Disk Number 

To allow for more reports printed to disk, the Print Reports from disk number was expanded from 4 digits to 7 
digits (9,999 to 9,999,999).  This affects any posting or regular reports generated on the system.  Pre-existing 

report numbers are not affected.  If they were 4 digits they remain that way. 

 Modifying Bank Routing Numbers 

When modifying a bank routing number a new warning message is displayed.  If the change is accepted, then 

the vendor and employee bank accounts are updated. 
 

Graphical Screens 
Many new graphical mode screens have been added to Accounts Receivable, Check Reconciliation and General 

Ledger. 

 
Graphical Lookups 

When using character mode screens, the graphical lookups introduced in PBS 12.00, are now accessible. They 
have easy click sorting and when appropriate, a "More info" button allows access to all the record data. 

 

Upgrade in Place Conversion 
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For existing PBS SQL users, when upgrading from 12.02 to 12.03, a new upgrade in place conversion is now 
provided. 

 

Accounts Payable 

Check Reconciliation Interface 

When interfaced to Check Reconciliation you have the option to automatically post payments to the Check 

Reconciliation checkbook. 

 

Accounts Receivable  

 Check Reconciliation Interface 

 

When interfaced to Check Reconciliation you have the option to automatically post deposits to the Check 

Reconciliation checkbook. 

 

New Invoice History Clean up Option 

A new Purge orphan secondary records field is available that removes corrupted data.                                Top 

 

 

New Graphical screens have been added for: 

 

Deposits > Deposit slips 
Deposits > Deposit summary 

 

 

Check Reconciliation  

 Checkbook Transfers 

A transfer type has been added to Checkbook entries. It transfers funds between accounts and updates General 

Ledger accounts appropriately. 

 

Automatic Transfer from A/P, A/R and PR 

You now have the option to automatically get deposits, checks and ACH payments to the Check Reconciliation 
checkbook when posting in the Accounts Receivable, Accounts Payable, and Payroll modules. When selected they 

bypass the Transfer checks/deposits function. 

 
New Check Reconciliation Options  

 
Post PBS Accounts Payable checks, direct deposit payments and voids automatically to Check Reconciliation. 

 

Post PBS Payroll checks and void checks automatically to Check Reconciliation. 

 

Post PBS Accounts Receivable deposits and returned checks automatically to Check Reconciliation. 

Graphical Screens 

Graphical mode screens have been added to the following Check Reconciliation menu selections: 



P a g e  | 3 

 

 

 

Passport Software, Inc. 181 Waukegan Road, Suite 200   

Northfield, IL  60093  800.969.7900  Fax 847.729.7909  www.pass-port.com 

 

 
Transfer checks/deposits 

View checking information 

Reports > Account activity 
Reports > Checkbook 

Reports > Checkbook list 
Reports > Distributions to G/L 

Reports > Reconciliation 
 

New Start-up Mode Option 

Start-up mode is used when you are adding Check Reconciliation your PBS system or a new checking account to 
C/R. If you have pre-existing Accounts Payable checks, Payroll checks or Accounts Receivable deposits, the first 
time you run Transfer checks/deposits, it may pull in hundreds or even thousands of ‘historical’ records into the 

checkbook. All these records must be cleared manually before you can move out of start-up mode.   

Now there is a new Transfer checks/deposits option to avoid pulling in the historical checks and deposits and 

mark them as transferred in the A/P, A/R or PR module. As a result, the implementation of Check Reconciliation is 

then much faster.                                                                                                                              Top 

General Ledger  

Changing Fiscal Years 

This new utility allows you to change your fiscal year end date.  As part of the process it backs up your old fiscal 
year G/L data to another company.  

 

New Graphical Screen 

The Make SAF layouts selection, found under Financial statement layouts is now available in Graphical mode.  

 

Order Entry  

 Immediate Invoice Printing in Select for Billing 

Immediate printing has been available through O/E Orders (Enter) for many years.  With PBS 12.03 you can now 

immediately print the invoice after selecting an order for billing. 

Limit Users from Deleting Orders 

In order to provide additional security there is an option to limit certain users from deleting orders in Orders 

(Enter) and Billing (Select for billing). There are two new fields in O/E Control information that implement this 

feature: Require Admin login to delete orders and Admin user ID. 

 Access the A/R View Invoice History from O/E View Invoice Screens 

In graphical mode screens for the View menu selections Invoice history by customer, Invoice history by invoice 
and Invoice history by item a new menu selection is provided to access A/R View Invoice history. When accessed 

it will locate and display the matching invoice. 

 Print Extended Weight on Forms 
When designing a form there is now an option include the extended weight.  The extended weight is the weight 

for one item times the number of items shipping.                                                                                                         Top 
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Ship in Full 
In order to save time a new "F7” = Ship in Full" function key option has been added to the Select for Billing, Line 

item selection window.  Hitting F7 selects the line even when the item is back-ordered.  When the item is back-

ordered the back-order quantity is changed to zero and the quantity to ship is changed to match the order 
quantity.  You do not have to go through the entire Edit, click on the field, enter the quantity, save cycle when 

you know that the full quantity is actually shipping. 

 

Payroll  

 Direct Interface to Check Reconciliation 

When interfaced to Check Reconciliation you have the option to automatically post payments to the Check 

Reconciliation checkbook. 

Windows Printer Check and Direct Deposit Mailer Formats 

A new, full graphical print image of the Payroll check and direct deposit mailer format allows for expanded pay 

details on the check stub. The Payroll check prints at the bottom of the page and the upper two thirds of the 

page is the stub. The improved check stub format provides additional space for printing more earnings and 

deduction information in a clearer easier-to-read manner. This new form type is available from Trainor Printing 

and Promotions at 847-296-2900.  

 IDES State of Illinois Reporting 

A new report is provided to comply with the Illinois Department of Employment Security.  This is a modified 

version of the Payroll Employee history report.   

Positive Pay 

To make positive pay more flexible and to comply with requirements for more banks, we now allow the employee 
name to be formatted in different configurations for the positive pay file.  

Employee Insurance Premium Field Expanded 

To comply with larger insurance premiums the Employees W-2 ins premium field was expanded from a maximum 
of $9,999 to $999,999.  This same expanded field is used for year-end reporting. 

 
2013 Payroll Year-End Updates 
The alignment of the 1099-MISC form has changed. This affects any 1099-MISC printed. Alignment has been 

updated for all supported PBS versions. 

‘Box 11. Foreign Tax Paid’ and ‘Box 12. Foreign Country or U.S. Possession’ have been added to form 1099-MISC. 

Since these fields are optional, only PBS versions 12.02 and above will allow entry of these values and print them 

on the 1099-MISC paper form and report the ‘Box 11. Foreign Tax Paid’ amount in the electronic file. (Note: 

There are no provisions in the current instructions to report the ‘Box 12. Foreign Country of U.S Possession’ value 

in the electronic file). 

Electronic W-2 records have changed as follow:                                                                                    Top 

The ‘Contact E-Mail/Internet’ of the Submitter record, aka ‘RA’ record, is required and must pass specific rules. 

This field was already required in PBS. Since the Social Security Administration AcuWages software validates this 

field, these validation rules are implemented only in PBS versions 12.02 and above. 

The ‘Other EIN’ of the Employer record, aka RE record, can already be entered and reported in this record in PBS 

versions. No changes required here. 

http://www.trainorprintingandpromotions.com/
http://www.trainorprintingandpromotions.com/
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Five new fields, all related to Contact information, have been added to the Employer record, aka ‘RE’ record. 

These fields are optional. They have been added to PBS versions 12.02 and above. The ‘Contact E-Mail/Internet’ 

value, if entered, must pass the same rules as the ones for the ‘RA’ record mentioned above. These validation 

rules are implemented in PBS versions 12.02 and above. 

Additionally implemented, the RA Submitter and RE Employer Contact Phone must contain only numeric entries 

and is left justified.  

Point of Sale  

 Sales Rep Number on Transaction Lookup 

We have added the sales rep # as the column heading to the transactions lookup. 

 

PBS Manufacturing 

Inventory Management: 
  

 Physical Inventory Freeze 

We have added the physical inventory function of "Freezing" the inventory when it's time to take a physical 

inventory. This will allow you more time to reconcile your inventory while not holding up daily transactions. 

Costed Inventory Status 

We have added an option to the Costed inventory status report to net negative values against the positive values 
to show a more accurate number when comparing to the G/L at month’s end. 

Shop Order Traveler 

This is an enhanced version of the Shop Order Pick List which is a list of items required to manufacture the 
product being made on a shop order. The information provided on the Pick List includes basic Shop Order 

information, a list of components and the total quantities required, as well as shop order comments.  This report 
is also available in Shop Floor Control (S/F). 

Post Stockroom Counts 

There is often a delay between the time that inventory is counted and when the results are posted. This allows 
posting in the correct period. 

 
A question was added to the entry screen "4. Use today’s date or count date for transactions?" with the entry of 

either C= Count or T = Today’s date.                                                                                                 Top 

 

PBS Version 12.02 

System Enhancements 
 
Print a Report from Disk A new graphical version of this screen is now available. It offers more sorting 

options, easier access to your reports and defaults to the date created in descending order, thus allowing you to 

find your recently saved reports more quickly.  
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SQL  

If your system was installed with multiple companies in PBS 12.01, each company was installed in the same 

database. Now with 12.02 each company is installed in its own database. The benefits are:  

• Improvement in the scalability of the system. Each company can now be up to 10 gigabytes when using SQL 

  Express.  

• Provides easer third-party vendor integration. The connection strings are movable from one company to 

  another.  

• Allows you to back up and restore one company at a time.  

Emailing  

 You may now email via an SSL email server.                                                                                        Top 

BreakOut  

There is now a global system switch to turn On or Off, access to the <F12> BreakOut key. Following the install 

the <F12> BreakOut key is accessible, but access may be turned off in the configuration (cblconfi) file. Turning 

off the BreakOut key controls the following:  

1. Users cannot change their BreakOut settings when they are set up by a PBS administrator. This sets the 

“policy” on the BreakOut settings for each user.  

2. Users cannot accidentally access BreakOut via the <F12> key which may confuse users not familiar with 

BreakOut.  

BreakOut runs in character mode only.  

Web Browser  

In previous versions, selecting the web browser button only provided access to the PBS User documentation. 

With 12.02 when an administrative user accesses the web browser  button from the PBS menu, they will now 

have access to all the PBS administrative documentation.  

The browser window now displays help independently so that it may be left open while using PBS.  

Report Progress Indicator  

Certain files and tables in PBS contain thousands and sometimes millions of records. Accessing all this data may 

take some time. An indicator now displays the progress of the function being performed on many reports and 

screens. Originally released with PBS 12.01.03, this feature has been added to more reports for 12.02.  

Add a Module/Package  

With 12.02 a new automated installation is provided that allows you to add a recently purchased module to the 

system.  

CPSQL Interface to PBS SQL  

When using the SQL version of PBS, there is new interface to NCR CounterPoint.                                      Top 
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PBS Graphical Screen Enhancements  

The full graphical version provides new screens and new conventions for data entry. If you are upgrading from a 

version prior to version 12, see the 12.00 New Features section.  

When using character mode screens, the graphical lookups developed in PBS 12.00, are now accessible. They 

have easy click sorting and when appropriate, a “More info” button allows access to all the record data. In 

character mode, the PowerTools lookups are no longer user definable or editable. If you are missing necessary 

lookup columns, that you had in PBS 12.00 or earlier, please report this to Passport support.  

 
Accounts Payable 

 
 Pay-to Addresses  

We now provide a way to enter a separate pay-to address per vendor. When you associate the pay-to address 

with a vendor, the pay-to address is printed on the vendor check. While entering payables, preparing payments 

and viewing vendor invoices, the pay-to address is indicated on the screen to help the user.  

For each check written, the pay-to address is stored in vendor history.  

In graphical mode, you may enter the pay-to addresses from the Vendors (Enter) screen.  

View vendor invoices  

The view vendor invoices graphical screen was modified to include additional data compared to the previous drill 

downs. This allows you to see all the invoices and optionally filter for invoices and payments for one vendor. 

Once you have found the vendor you want on the graphical screen menu, select View > View vendor invoices. 

There are six ways to sort the invoices. The sorting remains in the range of the invoices for the selected vendor.  

This graphical screen is accessible from Vendors (Enter) and many screens throughout A/P. It is also available in 

character mode via the Vendor lookup <F8>. Once the lookup displays, look for View vendor invoices from the 

Options menu. 

Accounts Receivable  

PBS Multi-Payment with Invoices                                                                                                         Top 

PBS Multi-payment processing provides a means of entering more than one payment per invoice. The payment 

types include Cash, Check and Credit card. You may also assign the invoice to terms. You may assign a different 

cash account to each payment type. Integrated credit card processing is provided with XCharge®.  

When setting up the payment codes, a different cash account may be used for each payment type which 

differentiates the amounts for G/L account totals and for check reconciliation.  

As stated above, you may apply the invoice amount to one or more payment types per transaction. For example, 

part of an invoice may be paid via credit card and check and the remainder can be applied to A/R terms. After 

posting the invoice, excluding terms, each payment applied to an invoice becomes a separate line in open items.  

The introduction and implementation steps are found in the PBS Multi-payment Setup appendix available in the 

A/R user documentation.  
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The PBS Multi-payment features are also available in Order Entry and Point of Sale.  

PBS Multi-Payment with Cash Receipts  

Although you can only enter one cash receipt payment at a time, multiple payment types are supported in a 
revised cash receipts graphical entry screen. The payment types include Cash, Check and Credit Card. Credit Card 

payments include credit card integration with XCharge®. The payment amount is determined by the total of the 

selected invoices. A new menu selection is provided for this function.                                                        Top 

Graphical Screens  
New graphical mode screens have been included for the following menu selections: 

Cash receipts  Cash application 

worksheet  

Returned checks  Enter 

Main menu  Sub menu  Main menu  Sub menu  

Returned checks  Edit list  Returned checks  Post  

Recurring bills  Enter  Recurring bills  Edit list  

Recurring bills  Select for use  Recurring bills  Use selected  

Recurring sales  Enter  Recurring sales  Edit list  

Recurring sales  Select for use  Recurring sales  Use selected  

Open items  Purge  Reports, general  Cash projection  

Reports, general  Collections  Reports, general  Cash History  

Reports, general  Commission due  Reports, general  Distributions to G/L  

Reports, general  Fully paid open items  Open items  Purge  

Reports, general  Goods and services  Reports, general  Invoice history  

Reports, general  Invoice ptr ctl stations  Reports, general  Open items  

Reports, general  Sales journal  Reports, general  Sales reps  

Reports, general  Sales tax due edit list  Reports, general  Sales tax exception report  

Reports, general  Ship-to addresses  Reports, general  Ship-via  

Reports, general  Standard bills  Reports, general  Statement ptr ctl stations  

Reports, general  Tax codes  Reports, general  Terms  

Master information  Invoice ptr ctl stations  Master information  Goods and services  

Master information  Sales reps  Master information  Ship-to addresses  

Master information  Ship via  Master information  Tax codes  

Master information  Terms  
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View – Invoice history  

The view invoice history graphical screen was modified to include additional data compare to the previous drill 

downs. This allows you to see all the invoices in history and optionally filter for invoices for just one customer. 

Once you have found the customer you want on the screen menu, select View > View customer. There are ten 

ways to sort the customer invoices. When sorting by customer, the list of invoices remains in the range of the 

invoices for the selected customer.  

This graphical screen is accessible from Customers (Enter) and many screens throughout A/R and O/E. It is also 
available in character mode via the Customer lookup <F8>. Once the lookup displays, look for View invoice 
history from the Options menu.                                                                                                         Top 

 

General Ledger  

Working trial balance  

The report now has a beginning balance column including a grand total.                                              
 

Order Entry  

PBS Multi-Payment with Orders and Invoices  

PBS Multi-payment processing provides a means of entering more than one payment per order or invoice. The 

payment types include Cash, Check and Credit card. You may also assign the order to terms. Integrated credit 

card processing is provided from PBS through XCharge®.  

When setting up the payment codes, a different cash account may be used for each payment type which 

differentiates the amounts for G/L account totals and for check reconciliation.  

As stated above, you may apply the order or invoice amount to one or more payment types per transaction. For 

example, part of an invoice may be paid via credit card and check and the remainder can be applied to A/R 

terms. After posting the invoice, excluding terms, each payment applied to an invoice becomes a separate line in 

open items.  

Entering payments on orders is optional, but required when entering invoices and credit memos.  

The introduction and implementation steps are available in the PBS Multi-payment Setup appendix found in the 

A/R user documentation. 

The PBS Multi-payment features are also available in A/R Invoices, Cash receipts and Point of Sale Transactions.  

Payroll  

 Additional Medicare Tax  
 

The Additional Medicare Tax went into effect January 1, 2013 applying to individuals' wages, other compensation, 
and self-employment income over certain thresholds.  Employers are responsible for withholding the tax on 
wages and other compensation in certain circumstances.                                                                          Top 

  

After meeting a threshold, PBS Payroll will include the additional Medicare tax automatically, as that employee 

qualifies. 
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Graphical Screens  

The following graphical mode screens were added:  

Define extended fields / Enter  

Define extended fields / Purge  

Reports, General / Annual reports (Mag media)  

Reports, General / Quarterly reports (Mag media)  

Utility / Pre-note ACH file and report  

PA Act-32  

PA Act-32 is now a standard part of the product and not a separate install as it was in versions PBS 12.01 and 

PBS 12.00. Systems using PA Act-32 MUST upgrade to version 12.02 in order to apply the year-end update for 

2012. PA Act-32 is no longer supported for PBS 12.00 and PBS 12.01 installations.  

Annual and Quarterly State Mag Media Reports  

There is now an option to round numeric amounts to the closest dollar amount for the magnetic media output 
and associated printed reports. This is a requirement for the state of Louisiana.                                       Top 

New Jersey State Reporting  

For reporting state income taxes for the state of New Jersey, an add-on install was introduced for year-end 2011. 

It allows users to enter up to 3 OST taxes when entering W-2 information. This feature is now standard in version 

PBS 12.02.  

Worker’s Compensation  

In previous versions the report could only be run by pay period date. Now there is an option to run it by check 

date.  

Point of Sale  

Immediate PDF Printing  

We now generate PDF files for immediate printing. PDF file generation has been included in past versions for 

batch printing, but is now available for immediate printing from the Transactions (Enter) screen. The setup for 

this is done in Registers. This includes -PDF- where only the PDF is generated and -PDFP- where both the PDF is 

generated and the document is printed.  

Alternate Units Now Supported  

Alternate unit pricing, as setup in Inventory Control items, is now available during POS transaction entry. On the 

quantity ordered field, you may change the unit of measure and the default price changes to match the selected 

unit of measure. 

When you select to use alternate units via POS Control information, you may also use the alternate unit pricing 

feature from I/C contract and sale pricing.  
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The PBS Multi-payment features are also available in A/R Invoices, Cash receipts and Point of Sale Transactions.  

 
PBS Manufacturing                                                                                                                             Top 

 

Customer Orders  

Sales orders > Bill of lading  

Currently, printing a Bill of Lading allows the user to print a Bill of Lading for a sales order. Now you can specify 

the vendor and P.O. number for an outside process. When the P.O. number is specified, the information comes 

from the Product Purchasing header and populates additional fields on the Bill of Lading.  

Custom Forms  

You now have the ability to create custom forms for Invoices, Quotes, Credit Memos and Orders similar to O/E. 

You still have the option to use the original system forms or develop your own custom forms.  

Inventory Management  

Displays > Shop material availability  

We now provide an indented view of the shop materials display. You can double click to drill down to the lower 

level component requirements when it is a manufactured item.  

Report and Display > Lot track – Reversed  

The Lot track display and report both allow the user to identify an item, select a prior lot, and then get a list of 

shop orders it was used on. In a separate section you may see a list of who it was sold to.  

With Lot track - Reversed you are looking to do the same in reverse. Essentially, you want to identify a finished 

product or assembly and then see a list of component lots used to make it.  

 

PBS Version 12.01.03 

General Ledger                                                                                                                                   Top 
 

General Ledger Reporting  

The accounting periods contain 2 non-closed fiscal years - one is for the current year and the other is the next 

 

year. The Trial balance, Working trial balance and Financial Statement reports now have complete access to data 

when working and reporting in the next year before closing the current year.  

When working in the next year, temporary files are created that do the “work” of creating access to the current 

year data. This allows you to work in the next year and still get the balance brought forward and comparative 

data from the current year. You are no longer required to close the current year in order to get this data when 

reporting in the next year. 

Temporary Close of Current Year  

When the Accounting Period data is set up for entering and reporting on next fiscal year, the Trial balance, 
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Working trial balance and financial statement reports access balance brought forward information, as if a Close a 

year had been run.  

Financial Statements and Extract Financial Data with Comparatives  

When reporting on the next year you no longer have to manually enter comparative data to report on it. 

However, you may prefer to manually enter the data. In graphical mode this new option now displays:  

Financial Statements > Enter specifications  

A variance column style was added to the P and L (Operating) statement.                                                Top 

 

PBS Version 12.01  

System Enhancements 
 

By far the biggest development effort we have created for PBS version 12.01 is the optional availability of 

PBS for Microsoft SQL Server®.    With the new COBOL/SQL file structure the data, now stored in tables, 

not files, becomes completely open to users. This opens a huge number of avenues for reporting and 
further integration with 3rd party tools and products. 

 
Added 18 new graphical screens.   

 
Batch totals (Enter) were added to the GUI Options menu for Batch controls. This by-passes the selection 

of package and process IDs when it calls Batch totals (Enter). It also reloads the list box when returning 

from Batch totals (Enter). 
 

Access to the graphical lookups from the character screens has been added. This means the "More info" 
button is now available to view the full data for any record from the file/table.  

 

The Vision COBOL files install for Windows is also available for V.12.01. 
 

 
Accounts Payable 

 

You can now add the vendor name to the Cash disbursements projection report. 
 

44 new GUI screens have been added to Accounts Payable which, except for a few minor screens, 
completes the GUI development of Accounts Payable. Many static menu selections were added to 

graphical screens. 

 

Accounts Receivable 
 

If the customer is on credit hold, the first tab **Credit hold** displays in red letters to the right of the 
customer name field. 

 
Invoices  

 

 On entering invoices you can allow the line item number to be either incremented by 10 as it 

currently operates, or by 1. If you change the first line number to 1, then increment the line 
number at 1 for that invoice.  If you change again, simply continue to add 1 to the new number 

you enter. 
 In the service description field, you are now allowed to just keep on typing. If you exceed the 50 
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character space allotted, open the extended description box automatically and just keep on 
typing. If you decide to delete characters to get it to fit on one line, then compress into the  

one-line field with no extended description. If you click on the description field and if there is 

extended description, then automatically open the extended description box. The dialog box that 
asks if you want to enter extended description has been removed as it should no longer be 

needed. 
 In the extended description box, you can format as you like with carriage returns or spacing as it 

currently works. When you hit TAB, close the box, displaying whatever is within the one-line field 

showing. If there is overflow into extended description, you can put the "more" indicator at the 
end of that line to indicate that there is extended description as it currently works.  But, make 

the "more" indicator clickable so that you can display the extended description in inquiry mode 

without going into edit mode, or in edit mode without going to the description field. Click once to 
show extended description and again to hide it.  

 You can now default the next new line item to the same type (Goods or Services) that was used 

for the last line item. 
 

Customer Orders 

 
Instant printing is streamlined with fewer button clicks or keystrokes and now includes instant invoice 

printing of an order. 
 

Positive pay 
 

Provides an option in the output of dates to not strip leading zeros. 

 
2 new GUI screens have been added. 

 

 
General Ledger 

 
40 new GUI screens have been added.  

 
View accounts - Trial balance  

 

 A new flag on the parameter screens to "Compress DR & CR trans separately?" has been added. 

 
 Now provides an option to do all regular compression (whatever is selected) and a new option to 

not compress any record with a journal # starting with GJ or ML. 

 
Financial Statements 

Added a variance column to the P and L statement.                                                                  Top 

 
 

 
Source cross reference 

Now allows reporting on closed fiscal years. 

 
 

Manufacturing 
 

Red sorting arrows have been added to the manufacturing module's graphical screens and lookups. 

 

Payroll 
 

Printing of 941 Forms 
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In order to print the 941 form, the program creates an adobe .xfd file that is used to merge the data to 
the F941.pdf form file. From there, the PDF data can be modified, added-to and the 941 form may be 

printed. 

 
Added 17 new graphical screens.   

 
 

Positive pay 
Provides an option in the output of dates to not strip leading zeros. 

 

 

Point of Sale 
 

Transactions  

Updated the X Charge interface to allow for partial payment approvals.   Top 

 
 

PBS V12.00.09  
 

Payroll: 
 

1) New York State Check Stub enhancement: 
 

This enhancement addresses a new law for the State of New York that went into effect April 9, 2011, 

requiring all rates per hour to be printed on the Payroll check stub.   
 

2) Added flexibility for Payroll Social Security and Bank Account Number Field encryption with the addition 
of three new optional PR control information fields: 

 

1. Optional encryption of the data files. 
2. Optional masking when printing and viewing of the numbers. 

3. Optional encryption when using the standard and extended file utilities.                       Top 

 
 
PBS Version 12.00.08 
 

Payroll 
 
Hire Act and Payroll Year-end Reporting  

 
 A new field has been added per employee to identify each Hire Act eligible employee.  For year- end 

processing a new report and update program will accumulate the exempted amount from Payroll 

history and write it to the Federal Auxiliary file for year-end reporting. 

 The new code CC has been added to the box 12 of the W-2 to report the exempted amount for each 

employee.  
 A new field has been added to the W-2 magnetic media to report the employer's amount exempted 

for each eligible employee.  

 

1099 Magnetic Media  

In the Payer "A" record the Combine State/Federal Indicator field was moved and Return type field has 

been expanded.  
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PBS Manufacturing:                                                                                                           Top 

 

Added new, graphical user interface on key programs and Smart Links to PBS™ Manufacturing.                                                                      

 

PBS Version 12.00.07 
 
Payroll 

 

Payroll Social Security number and employee bank account numbers  
Employee Privacy – Social Security Number (SSN) and bank account numbers for employees are now 

encrypted when stored in the PBS file system.  These values are obscured on all reports and screen 
views. 

 

   

System–Wide Enhancements 

New PBS Password Requirements 
Passwords must be at least six (6) characters long and include at least two of the following three 

elements; uppercase letter, lowercase letter or a numeral. 
All companies will require a password for access.        Top 

 
PBS Version 12.00.05 

 

Accounts Receivable 

New Graphical AR screens  
 

Tabbed screen format speeds up work processing. 
 

Cash Receipts application functions streamlined – locate open items more quickly. 

 
New AR “views” provide easier, faster access to information 

 
Screen highlights help emphasize the active window/box  

           

 
PBS Version 12.00.01 – 12.00.04  

 
Accounts Payable 

Added email button on the vendor contact entry screen. 

 
Provides a drill down from the pay-to vendor to the purchase-from vendor memos. 

 

 
General Ledger 

 
Produces compressed versions of the data for viewing and reporting. 
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Compression options provided on the graphical mode screens are now provided on the character screens. 
 

Added a new compression type, Date/Doc#. 

 
Renamed compression type Doc# to Doc#/Date, to show how it is being sorted and compressed. 

 
Programs will now report the reference when compressed by current date or doc/date or date/doc. 

 

Payroll: 

For electronic direct deposit, provides an option to pay a direct deposit percentage to an account on net 

and not just on gross. 

Federal tax table expanded to 8 federal withholding tax levels for the 2010 tax year. 
 

System- Wide Enhancements                                                                                                     Top 

Improved method of installing the PBS updates and displaying the new overall update version. 
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